Lab 1      Analyzing Costs and Projected Revenues
Microsoft Excel provides a variety of tools for designing and working with a spreadsheet, which is referred to as a worksheet. A worksheet) is simply a sheet organized into columns and rows; but with numerous features and functions that facilitate its easy and efficient use. An Excel workbook is a number of worksheets grouped together.
This lab presents some of the fundamental skills and tools you'll encounter when working with Excel to solve problems and support decision making. You'll learn how to write formulas in cells to perform calculations, and how to design a workbook so that these calculations can be automatically updated when input values are changed. In addition, this lab discusses some of the formatting options that can be applied to cells and ranges of cells.
You will also learn about some of the rules that affect how information is displayed and calculations are performed in an Excel worksheet. The coverage of formulas is expanded to cover simple functions, which are shortcuts available to use for predefined tasks. And, finally, you will understand the results of copying formulas with different types of cell references.
Case Scenario
The product design team at TheZone has been assigned the task of bringing to market a new and significantly different athletic shoe that will combine the support of superior European footwear with the comfort and styling of American running shoes. The design team has recently created a worksheet containing the component costs for this new athletic shoe, which is called TZEdge. The team members have asked you, a financial analyst for the company, to review the worksheet for several reasons. First, they want to ensure that it is formatted properly and contains no errors. Also, they need you to perform some cost calculations to determine the value of different pricing alternatives, and to provide some preliminary budget and projected revenue information. In this way, the worksheet will become a functioning analytical tool that will help both you and the product design team make sound business decisions regarding the launch of the new athletic shoe.
The product design team is working with you and production engineers to formulate an estimate of production costs for the new TZEdge athletic shoe. Although price will not be the overriding factor in the business decision to launch this new shoe, there are still certain production cost goals that must be met to place this shoe in the correct market niche. After the designers have all the information in place, you need to analyze the costs and make recommendations.
The designers started to tabulate the material costs of the TZEdge shoe. Figure 1 shows the Excel worksheet they have developed so far, which is contained in a workbook named "TZEdge Material Costs." To open the workbook file, you will click the Office Button located in the upper-left corner of the application window and select Open from the drop-down menu. All commands for opening, saving, and printing files can be accessed from the Office Button.
	





1: Initial worksheet for TZEdge
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)From your work with Excel, you know that cells can contain numeric values, such as the number 12 in cell C5; text labels, such as the word Components cell A2; and calculated values, such as the total 3d shown in cell D16. As you can see, the worksheet contains the cost information in the input area, cells A2 through E8, and the results of the cost calculations in the output area, cells All through D16. Typically, workbooks are organized so that there are distinct areas for inputs, the labels and values upon which the calculations are based, and outputs, the calculations and their results. The input and output areas can be located on the same worksheet or on separate worksheets.
As you can also see in Figure 1, there are some obvious problems with the worksheet. For example, cell E5 contains a series of ### signs. Also, a quick look at the numbers reveals that the Materials Total doesn't add up to the value shown. There are other problems related to formatting and formulas as well.
Excel uses a variety of symbols to indicate specific types of errors to help you identify and resolve problems in a worksheet. Table 1 describes some of these error messages. To learn about these messages or any of the other tools in Excel, use the Help feature available by clicking the Help button located in the upper-right corner of the Ribbon.



Table 1: Excel error messages
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[image: ]Figure 2 Worksheet after correcting formatting problems
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Because someone else has already created the spreadsheet, the focus here is on identifying the problems and testing the solution, which sometimes leads to rethinking and modifying various parts of the original solution. This task might involve many of the basic spreadsheet skills, including worksheet and cell formatting, as well as writing simple formulas.
Inserting Columns
In addition to being able to insert new rows within an existing worksheet, new columns can also be inserted. To insert a new column, select a cell anywhere in the column just to the right of where the new column is to be inserted. Using the Insert button arrow in the Cells group on the Home tab, select Insert Sheet Columns.
Selecting either multiple columns or multiple rows and then using the Insert Sheet Columns/Rows commands allows you to insert multiple columns or rows simultaneously. The number of columns or rows added corresponds to the number originally selected. When adding new columns or rows, be sure to clearly label the data so that it can be easily understood.

Best Practice - Documenting a Worksheet
Frequently when working in teams, with several groups, or even with different companies, it is advisable to include a title on the worksheet, identify the creation date, worksheet author, and any specific information about the company and/or project. Including this information on a separate documentation worksheet usually suffices for the workbook, but not if a single worksheet will be printed separately. For example, if the current worksheet were to be printed, it would be helpful to include the following information above the "TZEdge Material Analysis" title:
TheZone: TZEdge Product Design 
Team November 15, 2010 
Prepared by: <Your Name>
As an alternative to including such information on the worksheet itself, you can create a custom header. In Microsoft Office 2007, headers and footers can be modified using Page Layout view. They can be accessed directly by clicking the Header & Footer button in the Text group on the Insert tab. This places the insertion point directly in the center Header box and switches you to Page Layout view. Clicking either to the left or right allows you to enter text in the left and right sections of the header. To include page numbering or dates, use the Header and Footer Element group buttons in the Options group of the Header & Footer Tools Design tab, as shown in Figure 5. To return to Normal view, click any cell within the worksheet (not on the header or footer), and then select the Normal button on the status bar in the lower-right corner of the window, or select the Normal button in the Workbook Views group on the View tab.
Figure 5: Header in Page Layout view
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An alternate way of inputting a header or footer, which works in both Excel 2007 and older versions, is via the Page Setup dialog box. One way to access this dialog box is to click the Page Setup dialog box launcher on the Page Layout tab, and then select the Header/Footer tab.

 One way to determine where an error might exist in a formula is to print the worksheet in two different formats: the default format, which displays the values in each cell, and the format that displays the formulas instead of the values. Figure 6 shows both formats for the TZEdge Material Analysis worksheet. Note that when the formulas are displayed, the worksheet column widths and formats are modified to accommodate the display.
[image: ]Figure 6: Comparing values with their formulas &worksheet with values displayed
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How to Display Formulas in a Worksheet
1. Click the Formulas tab on the Ribbon.
1. Click the Show Formulas button in the Formula Auditing group.
OR
1. Press and hold the CTRL key while pressing " (grave accent) to toggle between the display of formulas and the display of values.
The information in cells A4:E9 was obtained from the vendors that the product design team dealt with when making the shoe prototype. Each of the different vendors quoted prices based on varying lot sizes: per item (each), per set, per inch, or per square foot (sf). The product design team then attempted to convert this information to a per-shoe basis.

Checking Formulas for Accuracy
The formula in cell D13 calculates the cost of leather per shoe. Each shoe requires 1.23 sf of leather. According to the component prices, the premium leather being used is sold at $19.86 per square foot (cell E4). The formula in cell D13 should multiply the quantity times the price. In Excel syntax, this formula would be =B13*E4. So, this formula seems to be correct. Notice that Excel uses an asterisk (*) to represent multiplication, as opposed to the "x" or "•"i which are symbols frequently used in algebraic expressions. Table 2 shows a list of the Excel arithmetic operators.
Table 2: Excel arithmetic operators
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Next, you look at the formula in cell D16, which calculates the cost of laces. Laces are priced by the inch. A total of 31.5 inches is needed for each shoe. The formula =B16*E7 was entered into cell D16. This formula also appears to be correct.

Using Formulas and Cell References Instead of Values
The formula in cell D14 should calculate the cost of arch support in the shoe. The arch supports are sold in lots of 1000, for a total price of $2235. So, the cost of each arch support is $2235 divided by 1000, as represented by the arithmetic formula 2235/1000. The number of arch supports in each shoe is 1 (cell B14), so the total cost should be 1*2235/1000. However, notice that the resulting value was directly typed into cell D14.

Typing a value into a cell instead of entering the formula that produced the value is not a good practice when building a spreadsheet. To correct this problem, you need to replace this value with the formula =E5/C5*B14 so that any later changes to any of these cell value inputs will be automatically reflected in the costs.

Best Practice - Using Cell References in Formulas
Notice the formula in cell D13. In addition to using the correct arithmetic operator, the formula in cell D13 contains cell references pointing to the appropriate input values. Using cell references is preferable to directly inputting values into a formula. In this example, if the price of the leather changes or the quantity required to make a shoe increases, it would be easy to enter those changes. By using cell references in formulas, you can be secure in the knowledge that everywhere you have used a value in your worksheet; the calculations will be automatically updated with any changes to that value.

Determining Order of Precedence
Now look at the formula in cell D15, which calculates the cost of trim, including two suede appliqué sets and two wedge logo inserts. The formula =E8+E9*2 was entered into cell D15. On closer inspection, this formula presents a problem. If one set of appliqués costs over $4 (cell E8), certainly two would cost at least $8, plus the cost of the inserts. Yet, the value displayed in cell D15 is only 7.
The problem is related to how Excel performs calculations, specifically in the order of precedence of the various operations. In this case, Excel performs the multiplication of E9 by 2 before adding the value in E8, resulting in the incorrect value of 7. To produce the correct results, the formula should first add the value in cell E8 to the value in cell E9, and then multiply that amount by 2. This would return the correct value 11.64 for the cost of trim. To fix this problem, you need to enclose the addition operation in parentheses to indicate that this should be completed first, as follows: =(E8+E9)*2. Table 3 describes the order of precedence rules in Excel.
Table 3: Order of precedence rules
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Understanding Precision vs. Display
You have corrected the problems with the formulas in cells D14 and D15. Figure 7 shows the revised worksheet.
Figure 7: Worksheet after correcting formulas
 (
=E5/C5*B14
=(E8+E9)*2
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Notice that the Materials Total value in cell D17 is still slightly off. If you manually add 24+2+12+1, the total is 39, not 40 as displayed in cell D17. The formula in cell D17 is =D13+D14+D15+D16, which appears to be correct. So, what is the problem?
Actually, there is no problem. The worksheet was originally set up to display the values in cells Dl 3:D17 with no decimal places. This display does not change the precise values that are stored in the cells. So, even though cell D14 displays the value 2, you know from the calculation 1*2235/1000 entered into that cell, the actual value stored is 2.235. The discrepancy is simply the result of the display being rounded; the precise values stored in each cell are correct. To test out this theory, you could revise the worksheet to display five decimal places, as illustrated in Figure 8. By manually calculating the Materials Total cost, you can see that the result in cell D17 is correct.





Figure 8: Worksheet with values displaying five decimal places
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Excel can display values in several different formats without changing the precise value stored by the program. When Excel rounds the display, it does so by rounding any number less than half down to the next value, and any number half or greater up to the next value. Remember that changing the display does not change the precise value stored; the stored value is the value used in any calculations. Table 4 provides examples of these format displays. These display options can be accessed from buttons in the Number group on the Home tab.
Table 4: Formats for displaying values
[image: Table1-4]
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In addition to changing the number of decimal places shown, you can also display a value as a percent without having to multiply by 100. A cell formatted with the Percent Style displays the % symbol following the value. When entering percentages, you can do one of the following:
· Enter the decimal equivalent, such as 0.23, and then click the Percent Style button in the Number group on the Home tab. The value in the cell is displayed as 23%, and the precise value stored in the cell is 0.23.  
· Format the cell as a percentage first, again using the Percent Style button, and then enter the value as either a whole number, such as 23, or as the decimal equivalent, such as .23.
· The value in the cell is displayed as 23%, and the precise value stored in the cell is 0.23.
· Type the value, such as 23, either preceded or followed by a percent sign (%23 or 23%). The value in the cell is displayed as 23%, and the precise value stored in the cell is 0.23.
· Dates are also a formatting option in Excel. Just like other values, dates can be added and subtracted in formulas. Usually when you enter a date such as 12/31/2009 or December 31, 2009, Excel automatically formats the entry as a date.
Working with Dates
Excel stores dates as sequential numbers beginning with January 1, 1900. For example, January 1, 2010 is the value 40179 representing the number of days since 1/1/1900. Excel stores times as decimal fractions. This enables you to perform numeric calculations on cells containing dates, such as adding or subtracting a specified number of days from a date to arrive at a new date, or determining the number of days between two given dates. The following are examples of date values used in formulas, assuming the date 1/10/2010 is stored in cell Al and the date 1/20/2010 is stored in cell A2:
=A 1 +10 produces the result 1 /20/2010 =A2-10 produces the result 1/10/2010 =A2-A1 produces the result 10
Note that dates cannot be used directly in a formula because Excel interprets the date as a calculation; for example, if the formula =1/10/2010+10 was entered in a cell, Excel would interpret this as 1 divided by 10 divided by 2010 plus 10—instead of as the date January 10, 2010 plus 10.
Date inputs and values resulting from calculations with dates can be displayed in a variety of ways, including numeric values, dates shown with the format 1/1/2010, or dates written out as January 1, 2010. These formats are available by clicking the Format Number dropdown box in the Number group. The drop-down box contains choices for several commonly used date formats. Additional date formats are available on the Number tab of the Format Cells dialog box.
Depending on which version of Excel you are using and how your options are configured, Excel allows two-digit year inputs, but they might be interpreted differently. In Excel 2007, the default setting interprets the values 00 through 29 as dates after 1/1/2000, whereas two-digit values from 30 through 99 are interpreted as years prior to 1/1/2000. For example, Excel would interpret the date 3/2/88 as March 2, 1988, not as March 2, 2088. It is usually a good idea to enter the full four digits of the year to avoid any types of problems.



Working with Multiple Worksheets
The product design team has been given the go-ahead to proceed with the project for the TZEdge shoe. The marketing group has just completed some testing with a small number of consumer focus groups. These focus groups have been extremely helpful in providing feedback to the design team. Most of the feedback has focused on two major areas: (1) the leather and styling and (2) the need for more ankle support for certain customers. As a result, the team has come up with two additional design options to consider:
· Textured leather that includes only a logo, and no appliqués, for trim
· A high top design similar to the original shoe
You need to compile some financial information to compare the material costs for each of these options to the original design. Refinements of the designs are expected to require several additional material components for one or more of these options. So, you need to plan accordingly when setting up the worksheet.
The corporate purchasing department has also supplied some information to help price the materials for these new designs. The cost of textured leather is estimated to be approximately twice the cost of the leather currently being considered. Also, the high top design requires approximately 25% more leather and twice the lace length.
Using the information calculated in the original design, you set up another worksheet in the TZEdge Material Costs workbook, listing the material costs for all three options. The costs on this new worksheet for the original option are based on the worksheet previously developed. Costs for the textured leather and high top options are based on the design requirements and cost estimates specified previously. To create the worksheet, you simply insert  a new worksheet in the existing workbook by choosing the Insert Worksheet button located to the right of the sheet tabs at the bottom of the window. Worksheets can also be inserted by clicking Insert Sheet on the Insert drop-down menu located in the Cells group on the Home tab. Figure 12 shows this new worksheet.
When working with multiple worksheets in a workbook, it's a good idea to rename each worksheet tab from the default labels (Sheet1, Sheet2, and so on) to assign names that better identify the worksheet contents. You can also apply color to worksheet tabs to further distinguish one worksheet from another. In this case, you rename the Sheet1 tab to "Original," because this worksheet contains the material analysis data for the original TZEdge shoe design; and rename the tab for the newly inserted worksheet to "Options," because it contains the data for the three different design options.








Solving Figure 12: Worksheet with additional design options
[image: ]
Rename and Add Color to a Worksheet Tab
1. To rename a worksheet tab, right-click the tab you want to rename, and then click Rename on the shortcut menu.
1. Type the new worksheet tab name to replace the highlighted name, and then press the Enter key or click any cell on the worksheet to continue.
1. To add color to a worksheet tab, right-click the tab, point to Tab Color on the shortcut menu,  and then click a color in the palette that opens. If you don't see the color you want, click More Colors at the bottom of the palette, and then use the dialog box to specify a custom color.
Calculating Totals Using the Sum Function
The next step in completing the Options worksheet is to calculate the material costs for each option. You could simply enter the formula =B3+B4+B5+B6+B7 in cell B8 to determine the total cost of the original option. However, as you saw earlier with the Original worksheet, this method does not allow additional rows to be inserted and formulas to be recalculated automatically. Because additional material components are expected later on, this method is not recommended. A better method is to use the SUM function.
In addition to writing formulas that use constants, cell references, and operands, you can also write formulas that include one or more functions. Functions are predefined formulas that perform calculations. For example, the SUM function adds a list of values and/or cell ranges. A function is always structured beginning with the function name and an opening parenthesis mark. After the parenthesis, the function contains a list of inputs in a specific order, separated by commas. A closing parenthesis mark ends the function. The function inputs are referred to as arguments. Each function has its own syntax, which specifies the function name and order of the arguments. The syntax can be compared with the spelling of a word, where each word contains specific letters in a specific order. A function always behaves in the same way, according to the rules programmed into the function. These rules are referred to as a function's algorithm. Later, you'll see how these rules can affect the values calculated and, therefore, how to use a particular function.


You need to include a formula with a SUM function in cell B8 to total the values for the original option, which are located in cells B3 through B7. As is true with any formula, this formula begins with an equal sign followed by the appropriate equation—in this case, just the SUM function. So, in Excel syntax, the formula in cell B8 is =SUM(B3:B7). In a similar fashion, you includes the formula =SUM(C3:C7) in cell C8, and =SUM(D3:D7) in cell D8. Note the syntax used in the SUM function—two cell references separated by a colon. This is referred to as a cell range. Ranges can be one-dimensional along a row or column, or even a two-dimensional block such as B3:D7, which includes all cells starting in B3 and going down to row 7 and then across to column D.
Functions can also be written as part of a larger formula. For example, if you wanted to calculate the material cost of a pair of shoes in cell B8 instead of a single shoe, you could modify the formula to the following: =2*SUM(B3:B7).
Insert a Function into a Formula
1. Enter the formula up to the point where you want to insert a function.
1. Click the Insert Function button to the left of the Formula Bar to open the Insert Function dialog box, shown in Figure 13.
Figure 13: Insert Function dialog box
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1. In the Select a function section, click the function you want (you might have to choose a category first to display the appropriate function list), and then click the OK button. The Function Arguments dialog box for that function opens.
1. Enter the appropriate arguments in the text boxes provided, and then click the OK button.
OR
1. Enter the formula up to the point where you want to insert a function.
1. Type the function name and each of the arguments required. When using cell references as arguments, you can either click the cells to include the references, or type the cell references. This method of using a function requires that you know the syntax of the function; however, after you type the function name and the opening parenthesis, Excel automatically displays the syntax for you, as a guide. Many experienced Excel users prefer this method of entering a function because it is faster than using the Insert Function dialog box.

Calculating Quickly with AutoSum
Excel's AutoSum feature gives you quick access to the SUM function and other similar functions. To use this feature, you select the cell in which you want to perform the calculation, and then click the AutoSum button   [image: ]    in the Editing group on the Home tab. This button can also be found in the Function Library group on the Formulas tab. Other common functions can be accessed by clicking the AutoSum button arrow |[image: ] to open a list from which to choose. After you choose the function you want, Excel presents a suggested range to include in the calculation, based on rows or columns of numbers next to the current cell. It is important to verify that this is the range you require because the range chosen by Excel might not always be the one you want. If necessary, simply type the appropriate cell references to modify the range.
Table 5 shows the Excel functions that are similar to the SUM function and simple to use. All of these functions are available from the AutoSum drop-down menu. Unlike the functions presented later in this course, these functions contain only one type of argument—a number. A number can be represented by a constant, a cell reference where a value resides, or a range of cell references.
Table 5: Commonly used Excel functions
[image: Table1-5]
Like the SUM function, these common functions take a list of number arguments, which can include one or more of the following:

· A range along a column; for example B3:B7
· A range along a row; for example B3:D3
· A two-dimensional range (also referred to as a block of cells); for example, B3:D7
· Noncontiguous cells and/or constants; for example, B3, C4, D5:D6, 6
You can obtain more detail about each of these functions by using the Help feature in Excel. You can access Help by clicking the Help icon or by clicking the Help on this function link in the Insert Function dialog box. It is recommended that you look at this information when you begin working with a new Excel function.

Help Information in Excel
Also I have provided a spreadsheet that lists all of the Excel functions and provides a link to the Help information on Microsoft’s Web site. You can access this spreadsheet at this URL:  cs.furman.edu/~pbatchel/mis/spreadsheetdemos/worksheet functions.xlsx
Calculating Average, Minimum , and Maximum Values
In addition to totaling the material costs for each option, you need to calculate the following:
· The average cost of each material component for each of the three options. This information will give the product design team a feel for the range of costs for each component.
· The lowest component cost and the highest component cost for all three options. This information was requested by the corporate purchasing department so they can get an idea of the range of cost component values, and so they can prioritize their purchasing efforts accordingly.
Cell E3 will contain a formula that averages the cost of leather for the three options, as follows: =AVERAGE(B3:D3). Similar formulas will calculate the average costs of arch support, trim, and so on. The following formulas will determine the value of the lowest and highest cost components, respectively, for all three options: =MIN(B3:D7) and =MAX(B3:D7). Notice that the range used in these functions is two-dimensional; it includes multiple columns and rows. The revised worksheet is shown in Figure 14.
The product design team recently received some information on additional materials that will be needed to produce the shoes. For the textured leather shoe a toe support brace is needed, as well as a toe support pad to cushion it. The braces cost $1.27 each, and the cushions cost $3.29 each. A back support cushion is also required for both the textured leather shoe and the high top shoe. The back support cushions are still being designed, but the purchasing group recommends using a cost of $5.00 each for the textured leather option and $6.50 each for the high top option, although these costs could change later.
You need to modify the worksheet based on this new information. You insert three rows just above the Materials Total in row 8 to allow for the three additional components: toe support brace, toe support pad, and back support cushion. The formulas for the totals automatically update to reflect the additional costs. Excel "senses" that the new rows are part of an existing list and either automatically includes the rows in the subsequent formulas or gives you the option to include the new rows. Also, Excel extends consistent formatting to the values in the newly inserted rows.






Figure 14: Worksheet revised to include average, minimum, and maximum costs
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Best Practice-Inserting Rows and the Impact on Formulas
Usually, when you insert rows in a list of values that is being calculated, such as with a total, Excel includes the newly inserted values and recalculates the formulas affected. Depending on what values are in the list and how they are formatted, however, this might not always work as anticipated. If you think additional rows will be needed, you can avoid potential problems in one of two ways:
· Insert the new row or rows within the list of values instead of at the end of the list. This ensures that the newly inserted values are incorporated in any formulas. This method is acceptable if the values can be listed in any order. If you want to maintain a specific order, you would have to copy and paste and/or retype some of the data to obtain the order you want. 
· Design your worksheet to include a blank row between the end of the list of values and the total formulas. The cell ranges you use in the formulas can include the blank row, and then whenever you insert rows, you can do so just above the blank row. This preserves the order of the values listed and ensures that all formulas are automatically updated. Because most of the commonly used functions ignore blank cells, the values generated should not be affected. When using this method, however, keep in mind that Excel might display an alert informing you that the formula refers to a blank cell. You can simply ignore this alert in this instance.
After inserting the rows, you enter labels in column A and the costs in the appropriate cells, leaving blank the cells for those options that do not include the three additional components. The revised worksheet is shown in Figure 15.





Figure 15 Values and formulas for revised worksheet with SUM, MIN, MAX, COUNT formulas
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[image: ]Figure 16 Final Worksheet with formatting


There are two additional options being considered for the TZEdge shoe as follows:
· Textured leather that includes only a logo and no appliqués for trim
· A high top design similar to the original shoe
The material analysis for the three options is in place. Next the labor costs must be determined. Figure 17 shows the labor comparison worksheet that has been developed. It contains the costs associated with the manufacturing tasks for one shoe produced with the original option.
The manufacturing group has been meeting to determine how different design options affect the number of hours and skills required to assemble the shoe. The group has provided the following information.







Figure 17 Labor comparison worksheet
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Creating a Budget Workbook
The task of compiling material and labor costs for the TZEdge shoe is complete. The next step is to set up a preliminary budget for each quarter of the first year of production and a combined summary. For now, you will produce this information for only the original option of the TZEdge shoe. You will also create budgets for the three different selling price alternatives: low priced, medium priced, and high priced. Table 6 provides the estimated sales volumes for each of these pricing alternatives in each quarter and the associated shoe prices. The expenses such as material costs and labor costs per shoe will be constant in each alternative and in each quarter, though the volumes will vary.



Table 6: Shoe prices and estimated sales volumes
[image: Table1-6]
From your earlier analysis of material and labor costs, and with new information provided, you know the following about the original option:
· Material costs total $50.15 per shoe. 
· Labor costs total $7.33 per shoe.
· Overhead costs are calculated as 25% of the direct labor costs. 
· Selling expense is calculated at $10 per pair of shoes, or $5.00 per shoe.

Organizing the Workbook
With the necessary information in hand, how should you organize the new budget workbook? Consider the Options worksheet created earlier (Figure 16). In this worksheet, all the inputs and outputs for the three design options are displayed on the same worksheet. This layout is easy to read and implement because there are a limited number of options and relatively simple calculations. But what if each design option had a completely different set of data inputs, or the values of the inputs varied from option to option? In such a case, it might be easier to create separate worksheets for each design option, or put all the inputs together on one worksheet and the outputs together on another.

For the budget workbook, you need to organize data for four quarters, with each quarter containing data for the three different pricing alternatives. If you placed all the data on one worksheet, it would contain 12 separate sets of calculations and inputs. Although this is possible, such an organization would make the worksheet cumbersome to manipulate. Figure 18 illustrates and compares several possible ways to organize the budget workbook.
Note the following:
The first organization places all the inputs on one worksheet and all the outputs on another. This is a simple organization but, again, might be difficult to work with and could cause confusion, because it would be difficult to ascertain which set of inputs are associated with a particular output.
· The second organization is by quarter. The inputs and outputs are placed on a single worksheet, with each worksheet containing all three pricing alternatives for a specific quarter.
· The third organization is by pricing alternative. The inputs and outputs are placed on a single worksheet, with each worksheet containing all four quarters for a specific pricing alternative.


Figure 18: Possible workbook designs
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Which workbook organization should your choose? That depends on what you want to emphasize and compare, and what elements are most likely to change. Because management is probably most interested in the financial ramifications in each quarter, you decide to organize the worksheets by quarter. In this way, a single sheet will contain both the inputs and outputs associated with a specific time frame. The worksheets will be named 1stQTR, 2ndQTR, 3rdQTR, and 4thQTR. After entering the information for each of the four quarters, you can easily combine the data into a summary on a separate sheet named Summary.
To create the worksheets for the four quarters and the summary, you could select all five worksheets simultaneously by clicking the first tab and then holding down the Shift key and clicking the Summary worksheet tab. Everything you enter would be entered on all five worksheets at the same time. The values and formulas entered for the first quarter would be recorded on each selected worksheet in the identical way. So, if the cell in sheet 1stQTR!B7, for example, contained the formula =SUM(B1:B6), it would add cells B1 to B6 only on the 1stQTR worksheet. The same formula would be entered simultaneously in cell 2ndQTR!B7 and would add cells B1 to B6 on the 2ndQTR worksheet. After setting up the worksheets in this way, you could edit those values that are different for each quarter. Keep in mind that this method only works well on worksheets with identical structures. Furthermore, caution should be used when creating and modifying a workbook in this manner. Although this method is convenient, you could damage your workbook by inadvertently making changes, such as deleting values or formulas, to multiple selected worksheets when you intended to make the changes on only one worksheet.
Note the syntax used for referencing cells with their worksheet names. First is the sheet name, followed by an exclamation point "!", then the usual column letter and, finally, the row number. Sheet names are only needed in formulas when the cell being referenced is on another worksheet.
Another approach would be to simply complete the first quarter worksheet with no other worksheets selected. Then, you could select the entire worksheet or specific ranges and copy them to the other sheets, again making the appropriate changes as needed. This is the method you use. You begin by creating the 1stQTR worksheet, shown in Figure 19. Labels and values list the revenue and expense items down the column, and the volume values for each of the three pricing alternatives are listed across the row. Also, some of the inputs needed in all four quarters are listed at the top of the worksheet in cells B1:B2.
Figure 19: First quarter budget
 (
Volume and pricing per pair
Shaded cells for calculations   
Cost inputs per shoe
)[image: ]
Notice cell B13, which contains the formula that calculates the unit cost (cost/shoe) of overhead for the original option. Because overhead is given as 25% of direct labor (see cell B2), the formula in cell B13 multiplies the labor expense $7.33 by 25%. In Excel syntax, this formula is =B12*B2. Note that cell B2 can be used directly in the formula because it has been formatted as a percentage; the precise value stored is still 0.25. To clarify the work remaining to be done in the worksheet, the cells in which formulas need to be entered are shaded.
Understanding Relative Cell Referencing
You need to create the necessary formulas to calculate revenues and expenses for the original option of the TZEdge shoe. The costs of material and labor on a per-shoe basis are taken from the analyses done earlier. You will need to adjust these values later to multiply them by 2 because sales volumes are based on pairs of shoes.
Revenue can be calculated as sales volume times selling price. So, the formula =C5*C6 is entered in cell C8. Rather than create similar formulas in cells D8 and E8, wouldn't it be convenient if there was a way to tell Excel to use the same formula, but with a different set of data? In fact, Excel has the ability to change a formula relative to the location of the original formula. This allows you to use a "general" formula over and over again, but with a different set of numbers. To do this, you use a feature called relative cell referencing.
When you copy a formula from one cell to another, Excel automatically alters the new formula relative to where it is being copied. So, if you have the formula =C5*C6 in cell C8 and copy it to cell D8, a displacement of 1 column and 0 rows, the formula is rewritten adding 1 column and 0 rows to each relative cell reference. There are two of these references in this formula: the first is C5 and the second is C6. If you add 1 column to C, it becomes column D. If you add 0 rows to 5, it remains 5, resulting in the cell reference D5. In a similar manner, the cell reference C6 is changed to D6. The new formula is now =D5*D6, which is the formula needed in this case. This process is illustrated in Figure 20.
What about formulas that contain functions or constants? An example of this might be a formula to calculate the average sales volume and average selling price. If the formula =AVERAGE(C5:E5) was placed in cell F5, what would the resulting formula be if it was copied to cell F6? Here, the displacement is 0 columns and 1 row, resulting in a new formula in cell F6, =AVERAGE(C6:E6).
What happens when you copy formulas from one worksheet to another? Consider what would result if the formula =C5*C6 was copied from cell C8 on Sheet1! to cell E11 on Sheet2!. What is the displacement in this case? Because no sheet name is specified in the cell references, when the formula is copied, it would refer to cells on Sheet2! instead of Sheet1!. Which cells would it reference on Sheet2!? Here is the process:









Figure 20: Copying formulas with relative cell references

[image: ]
The displacement from C8 to Ell is 2 columns and 3 rows.
· Take the cell reference C5 and add 2 columns, 3 rows: this results in the new reference E8.
·  Take the cell reference C6 and add 2 columns, 3 rows: these results in the new reference E9.
·  When these elements are put together, the resulting formula is =E8*E9. Because this formula was copied to another worksheet, it now references these cells on the new sheet.
Formulas can also be copied in the opposite directions, back up columns, and farther to the left on rows. For example, the formula =D9*C7 could be copied from cell E9 into cell C8. In this case, the displacement is minus 2 columns and minus 1 row, resulting in the formula =B8*A6. You need to be careful that the resulting formulas contain only valid references. Copying a formula such as =A2+C3 from cell C4 to cell B3 would result in a #REF! error because it is not possible to go minus 1 column farther than column A.
You enter the formula =C5*C6 in cell C8 and copies it, using the fill handle, to cells D8 and E8. When copying formulas, you can use the copy/paste techniques, but it is easier to use the fill handle if you are copying to adjacent cells. The fill handle is a small square in the lower-right corner of a selected cell or cells that you drag to copy the contents of the selected cell or cells. The current worksheet is shown in Figure 21.

Copy Formulas Using the Fill Handle
1. Select the cell or cells containing the formula(s) that you want to copy.
2. Place the pointer on the lower-right corner of the selected cell(s) until it changes to a plus sign which indicates it is positioned over the fill handle.
3. Press and hold down the left mouse button and then drag the mouse down or across, as necessary, into one or more adjacent cells. This automatically copies the formula(s) into the adjacent cells indicated.
Figure 21: Revenue formulas filled across
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Understanding Absolute and Mixed Cell Referencing
Next, you need to calculate the total cost of materials. This calculation takes the number of shoes per pair, times the materials cost per shoe, times the sales volume. For the low-priced alternative, this formula is entered in cell C11 as =B1*B11*C5. As with the revenue calculation, it would save time if this formula could be copied from cell C11 across row 11, varying the sales volume for each corresponding pricing alternative. In fact, it would be ideal to copy this same formula down column C, substituting the cost of labor and then the cost of overhead for the cost of materials. As currently written, if the formula =B1*B11 *C5 was copied from cell C11 to cell D11, a displacement of 1 column and 0 rows, the resulting formula would be =C1*C11*C5. Not only would the cell reference for the sales volume change, but the references for the number of shoes per pair and the materials cost per shoe would change as well. This would not work; cell C1 is blank and cell C11 contains the value just calculated for the materials cost per shoe for the low-priced alternative.
What you want Excel to do in such a case is to vary some of the values, but not others. For some operands, you want nothing to change; for others only the row should change; and for still others only the column should change. Can this be done? The answer is yes. In addition to relative cell references, Excel allows you to indicate that a cell reference (both column and row) or even a part of a cell reference (column or row) can remain unchanged when copying. This is called absolute cell referencing. The syntax used by Excel to indicate that a cell reference is absolute is a dollar sign "$" placed either before the column letter, before the row number, or both. A cell reference that has only one $ is referred to as a mixed reference. Mixed referencing is common when you need to copy a formula both down a column and across the row at the same time.
You can apply absolute and mixed cell referencing to the formula you enter in cell C11, =B1*B11*C5, as illustrated in Figure 22.
Figure 22: Using absolute and mixed cell referencing
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[image: ]Figure 23 First quarter budget values and formulas displayed
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How to Change a Cell Reference to an Absolute or Mixed Cell Reference
1. Type the cell reference in your formula or click the cell you want to include in the formula.
1. Type the dollar sign(s) needed to make the cell reference absolute or mixed.
OR
1. Type the cell reference in your formula or click the cell you want to include in the formula.
1. Press the F4 function key to add the dollar sign(s) needed to make the cell reference absolute or mixed. The F4 function key cycles through the display of dollar signs. If you press F4 once,  the cell reference changes to an absolute reference, with dollar signs before both the row and column. If you press F4 twice, only the row is made absolute; and pressing F4 a third time makes only the column absolute.


Naming a Cell or Range
Another technique that can be used to address a cell reference absolutely is to give that cell a name. You can name a single cell or a cell range, and then use that name directly in a formula. To name a cell or range, you first highlight the cell or cells to be named and then click the Name box, just below the Ribbon. If you name cell 1l "pair," for example, then instead of using the cell reference $B$1 in the formula, you could write =pair*B11*C5. Note that range names, unlike text labels, are not enclosed in quotation marks when used in formulas. If you attempt to use a name that has not been defined, Excel displays the error message #NAME!.
Writing a Formula to Subtotal the Cost of Goods Sold
The next calculation you need to perform is to subtotal the Cost of Goods Sold (COGS). This formula can simply be written in cell C14 as =SUM(C11:C13). Again, because this formula must be copied across the row, you must consider whether any absolute cell references are required. In this case, each of the cost values for each of the pricing alternatives should change, so the cell references are relative and no dollar signs are required.
Using Absolute Cell References Appropriately
When copying a formula both down a column and across a row, the placement of the $ absolute signs is critical or the wrong values will result. When copying in only one direction, either just across a row or just down a column, often the addition of extra $ absolute signs will not affect the calculated outcome, but can make for less efficient and confusing formulas. For example, you might be tempted to write the formula =SUM(C11:C13) as =SUM(C$1 1 :C$1 3) because you want the column references to change, but you do not want the row references to change, when the formula is copied across the row. However, when you are only copying a formula across a row, the row won't change. There is no displacement, which makes the $ superfluous. This also holds true for adding $ to column references when a formula is only being copied down the column. As a matter of good formula writing technique and to maintain the efficiency of your worksheets, you should minimize the number of $ absolute signs in your formulas and include them only when necessary.

Writing a Formula to Calculate Selling Expense
Before calculating the projected earnings, you need to determine the selling expense. Again, you need to calculate the cost per shoe—in this case by multiplying selling expense by both the number of shoes per pair and the sales volume for the associated pricing alternative. This is the same formula used for all of the COGS expenses. So, the formula can be copied from any one of the COGS expense formulas, such as the formula in cell C11, into cells C16:E16. Because cell C11 and C16 are not contiguous, the fill handle cannot be used to copy the formula. To complete this task, you will need to use the copy and paste features.

Writing a Formula to Calculate Projected Earnings
Finally you are ready to determine if the original TZEdge shoe is estimated to earn any profit in the first quarter of sales. Because this worksheet is intended to provide only a rough idea of the profitability of this venture, you have not included any detailed accounting terminology or taken into account investment costs, which are unknown, or taxes. The term “projected earnings’ for the purpose of this analysis is defined as revenue minus COGS minus selling expense. You write the following formula in cell C18 to represent projected earnings for the low priced option = C8-C14-C16. This formula can then be copied across the row into cells D18 and E18. Because each of the values changes relatively, no absolute cell referencing is required. The finished first quarter budget is shown in Figure 24.

Figure 24 Finished first quarter budget
[image: ]

Completing the Budget Worksheet
To complete the budget workbook, you need to create similar worksheets for the second, third, and fourth quarters, as well as a summary worksheet showing the annual budget. To do so, you simply copy the 1stQTR worksheet and paste it to the other worksheets.
To Copy a Worksheet
You can choose from the following methods to copy an entire worksheet:
1.	Use the sheet selector box:
· Select the entire worksheet using the sheet selector box in the upper-left corner of the worksheet (above row 1 and to the left of column A).
· After the sheet is selected, click the Copy button on the Ribbon, or right-click the selection,
and click Copy on the shortcut menu, or type CTRL+C.
· Select the worksheet where the data will be copied to, and, if necessary, select cell Al. Click the Paste button.
OR
2.	Use the Sheet tab menu:
· Right-click on the sheet tab of the sheet to be copied.
· Click Move or Copy on the shortcut menu. The Move or Copy dialog box opens. You could also open this dialog box by clicking the Format button in the Cells group on the Home tab, and then selecting Move or Copy Sheet in the drop-down menu.
· Indicate the desired location of the copied sheet. To specify that you want to copy rather than move it, click the Create a copy check box.
· Click the OK button.
Because none of the cell references used in the 1stQTR worksheet refers to a particular worksheet, the formulas adjust relative to the new worksheet when copied. you then substitute the appropriate sales volumes in each of the corresponding quarters on the remaining worksheets. The revenue and expense values are updated automatically.
To create the summary worksheet, you can copy any one of the quarterly budgets to a separate worksheet and then name that worksheet "Summary." In each cell where you want to aggregate the four quarter values, you can write a formula to add the corresponding values from quarter 1 + quarter 2 + quarter 3 + quarter 4. Starting in cell Summary!C8, you could write the formula =1stQTR!C8+2ndQTR!C8+3rdQTR!C8+4thQTR!C8, either by entering the formula directly or clicking the appropriate worksheets and cells. It is also possible to use the SUM function and then select all four worksheets simultaneously and click cell C8 in one of them. The SUM function might be more efficient if additional worksheets will be inserted within the group later on, but it could also prove problematic if a worksheet is inserted but its values were not intended to be included in the formula
When working with multiple worksheets, as soon as one cell contains the correct formula, you can simply copy the formula into all other cells to calculate their corresponding values. When the cell references in the formula contain a sheet name, the copied cell references still refer back to the corresponding worksheets. You use this method to add the sales volume values for each of the three pricing alternatives.
The final summary sheet is shown in Figure 25. Based on the projected earnings calculated, it appears that the low-priced alternative is the best option, at least regarding profits generated for the original shoe design. The volume seems to more than make up for the lower selling price per pair of shoes.












Figure 25: Annual budget summary
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Working on your own
You have learned about creating the first year's budget for the original option of the new TZEdge shoe. Now, you need to create quarterly budgets and a summary for the textured leather option using $74.07 per shoe as the cost of materials and $4.75 per shoe as the cost of labor.
Unlike with the original option, only two pricing alternatives are being considered for the textured leather option. Table .7 shows the two pricing alternatives, as well as the expected sales volume in each quarter for these alternatives. Overhead is calculated at 35% of the direct labor costs, and the selling expense is assumed to be $10 per pair, or $5 per shoe.
Table 7: Shoe prices and estimated sales volumes for the textured leather option
	
	
	1stQTR
	2ndQTR
	3rdQTR
	4thQTR

	Alternative:
	$/Pair
	#Pairs
	 #Pairs
	#Pairs
	#Pairs

	Low Priced
	225
	660
	800
	1,050
	1,200

	High Priced
	275
	225
	289
	335
	350


Complete the following:
1. Create a new workbook named Textured Budget <your name>.xlsx and save it in the to your USB drive.
1. Using the finished first quarter budget worksheet for the original option as a model (see Figure 24), create a similar first quarter budget worksheet for the textured leather option, as follows:
a. In cells A1:B2, enter the necessary inputs for number of shoes per pair and overhead.
b. In cell C1, enter the title "TZEdge 1st Quarter Budget Textured Leather Option" in bold and italic; merge and center this tide across cells C1 :D1.  Apply a gray shaded background to the title cells.
e. In rows 4 through 6, enter the sales volume and selling price data, with the column headings "Low Priced" and "High Priced" in cells C4 and D4, respectively. Use similar formatting as shown in Figure 24. (Next page)
d. In cells A7:A18 and B7:D7, enter the same labels as for the original option (see Figure 24).
e. In cells B11, B12, and B16, enter the costs per shoe for Materials, Labor, and Selling Expense, respectively.
f.  In cell B13, enter a formula to calculate the Overhead cost.
g. In columns C and D, enter the necessary formulas to determine revenue, cost of goods sold, selling expense, and projected earnings for each pricing alternative.  (Keep in mind that projected earnings is defined as revenue minus cost of goods sold minus selling expense.) Be sure to use the correct relative, absolute, and mixed cell referencing so that the formulas can be copied wherever it makes sense to do so, and so that the formulas will automatically update if any of the data inputs are later modified. Format the values and calculated results on your worksheet in a similar manner to those in Figure 24.
h.  Refer to Figure 24 and apply similar borders to the appropriate cells on your worksheet.
i. Rename the Sheet1 worksheet tab as "1stQTR."
Figure 24
[image: ]
1. With the 1stQTR worksheet complete, use an appropriate method to create similar worksheets  for  the   other  three   quarters.   Name  these  worksheets  "2ndQTR,"  3rdQTR," and "4thQTR." Modify values and labels as necessary on these three worksheets.
1. Create a final comparison sheet named "Summary" that displays each of the budget components summarized by year for each pricing alternative. For the worksheet title in cells C1:D1, enter "TZEdge Annual Budget Textured Leather Option."
1. In cell A20, insert text to indicate which pricing alternative you would recommend, and why. Highlight this text with a yellow background.
1. Save and close the completed Textured Budget<your name>.xlsx workbook.




CONCEPTUAL REVIEW
1. What is the meaning of each of the following error messages:
· ######  
· #NAME?  - 
· #N/A  
· #REF!  
· #VALUE!  
· #NUM!  
· #DIV/0!  
2. If you enter 2,806+4 in a cell exactly as shown (without an equal sign), what value would result? 
3. If you enter =3+2*10 in a cell exactly as shown, what value would result? 
4. List each of the following operations in order of precedence, from 1 to 4 (first to last):
· multiplication and division 
· ( ) parentheses  
· addition and subtraction 
· exponentiation 
5. When writing formulas, why is it preferable to use cell references rather than typing in values? – 
6. In the worksheet below, cell A3 contains the formula =A1+A2. Explain the most likely reason the value calculated appears incorrect.
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7. Referring to the above worksheet, if you wrote the formula =B1*120, what value would result (assuming the displayed value is the precise value)?

8. What formula would you write to do each of the following:
a. Add a range of numbers in cells A2:Z2.  
b. Find the largest value in cells B2:B8. 
c. Find the smallest value in cells B2 through Z12.  
d. Find the average value in cells C1 through C10; assuming blank cells will be ignored. 
e. Find the total number of items listed in cells C1 through C10 including any that contain text. 

9. If the formula =$B$4–SUM(A1:A5) is copied from cell A9 to cell C10, what will the resulting formula be? 

10. Refer to the following worksheet. Write a formula in cell B2 that can be copied down the column and across the row to complete the multiplication table.
[image: ]

11. What new formula would result for each of the following if the formula was copied from cell B3 to cell D6?
a. =A1+A2		
b. =$A$1+A2		
c. =$A1+A2              
d. =A$1+A2              

12. What formula could you use to add up cell A1 from Sheet1!, Sheet 2! and Sheet 3!?   

13. Cell B1 has been given the range name “tax.” How would you write a formula in cell C1 that multiplies the tax by A1? What new formula would result if you copied this formula into cell C2?  



Case Study – Analyzing Regional Sales Information for CKG Auto

As a regional sales manager for CKG Auto, you have just finished summarizing sales data for the first half of this year (January through June) aggregated by car model. You have started to enter data in an Excel worksheet, which lists by model the following:
Sales Volume indicating the number of cars sold to dealers.
Manufacturing (Mfg.) Cost per Vehicle,
Total Cost of all vehicles sold for the model. You will need to calculate this based on the sales volume and the manufacturing costs per vehicle.
Markup Percentage, which is the percentage charged above manufacturing cost to
dealers.
Total Sales to dealers. You will need to calculate this as Total Cost plus Markup. (Markup
is the markup percentage times the manufacturer cost of the vehicle.)
% of Total Volume. You will need to calculate this based on volume for the model as compared with the volume of all models sold for the time period.
First, you need to complete the January through June computations based on the data contained in the worksheet and the information given. Then, you have been asked to create a similar worksheet to estimate sales for July through December based on volume supplied by the marketing group. These volumes are based on the historical values adjusted for seasonal demand of specific car types and from market research data on car popularity.
After you have completed both the first half actual sales and second half estimated sales, you need to combine this data to determine expected yearly sales. Management is not only interested in the absolute value of those sales, but each model's contribution to the total yearly sales in each half of the year and in aggregate.
When you complete the workbook, verify that all data is correctly referenced so that your formulas will work as you copy them down the column or across the row, as necessary.

Your first task is to complete the Sales Summary for January through June by writing the necessary formulas in the cells that are highlighted in the Excel worksheet.
Complete the following:
1. Open the workbook named Sales.xlsx located in the Lab 1 folder, and then save it as Auto Sales.xlsx. Rename the Sheet1 worksheet tab as 1st Half.
1. In the highlighted cells, enter formulas to perform the necessary calculations. Be sure to write all formulas so that they can be copied as necessary. Note the following:
· Display all dollar values in whole dollars and include the dollar sign in the first row and total rows only.
· When calculating averages, do not include any models that had no sales. Display all average values (other than the percentage) with commas and no decimal places.  The formulas in column G need to determine the percent of total volume sales that the vehicle represents. (That is, if model A sold 100 cars and a total of 1000 cars were sold for all models, then model A would represent 10% of the total volume.)
Format the cells in column G to display values to the nearest tenth of a percent.

1. Your next task is to create an estimate of the July through December sales based on marketing data and the first half-year sales values. The marketing group has provided a list of all car models in identical order to the original data you received, with the expected sales volumes for each car model. This list is found in the workbook named Market.xlsx, which is located in the Lab 1 folder. Manufacturing costs and markups are assumed to be the same for the second half of the year as they were for the first half. With the data and assumptions in mind, create a new worksheet named 2nd Half in the Auto Sales.xlsx workbook, identical to the 1st Half worksheet. Copy and paste the sales volumes from the Market.xlsx workbook into your new worksheet.  Verify that all the calculations in the new worksheet reflect the new data.
1. Create another new worksheet named Summary, and include the column headings shown in Table 10 on this new worksheet.
Table 10: Column headings for Summary worksheet
	Model
	Annual Volume
	Jan-June Sales to Dealers
	July-Dec Sales to Dealers
	Total Sales to Dealers
	%Total Sales to Dealers Jan-June
	%Total Sales to Dealers July-Dec
	%Total Sales to Dealers Annual



5. Insert the model numbers in the identical format as shown on the 1st Half and 2nd Half worksheets.
6. Insert the annual volume for each model—the combined totals of the January through June and the July through December volumes. Make sure that the values will automatically update if any of the input values are changed at a later time.
7. Insert the Jan-June sales to dealers, again ensuring that these values will automatically update if any of the input data changes.
8. Insert the July-Dec sales to dealers, again ensuring that these values will automatically update if any of the input data changes.
9. Create a combined total of sales to dealers for the entire year.

10. Calculate the total volumes and the total sales to dealers for each time period and annually in a row below the data.
11. Calculate the percentage of sales to dealers that each model represents, as a percentage of the total sales to dealers for all models—first for the Jan-June time frame, then the July-December time frame, and finally for the annual values. Use only one formula for this calculation and make sure that the formula can be copied down the column to calculate the percentages for the corresponding models, and across the row to calculate the percentages for the corresponding time frames. Display the percentage values with an appropriate format and number of decimal places.
12. Format all three worksheets so that they have a professional appearance.
13. Save and close the Auto Sales.xlsx workbook.
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Table 1.

: Excel arithmetic operators

Calculation Excel Operator | Example
Addition + =3+A1
Subtraction =A1-A2
Multiplication * =A1*4
Division 7 =X4/Y4
Exponent ~ 278
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Table 1.3: Order of precedence rules

left to right

2+3*10, or 2430, =32

g'd"ﬁf.‘, Example Resulting Value Explanation

1. Operations in | =A1*(3+5) If A1=2, the resulting value is | Excel first performs the addition of

parentheses 2*(3+5), or 2*8, =16 3+5 even though multiplication has
ahigher precedence than addition,
because the addifion operation is
enclosed in parentheses.

2. Exponentiation | =3*A113 If A1=2, the resulting value is | Excel first performs the exponential

3*23, or 3*8, =24 operation of cubing Al, and then

performs the muln;ﬁicmion.

3. Multipl —A1+B2°C3 [FA1=2, B2-3, and C3=10, | Excel first mulliplies B2 by C3, and

and division from the resulting value is then adds the result to Al.

4. Addifion and
subtraction from
left to right

=A182+C3/10

[FA1=2, B2=3, and C3=10,
the resulting value is
2:3+10/10, or 2-3+1, or
141,=0

Excel first divides C3 by 10, then
subtracts B2 from A1, and finally
adds this value to the quotient.





image10.png
Home | Insert

Page Layout

Fomulas  Data

% cut = . p [ | - e | X Autosum - %7
Siwiap Text General I w
(3 Copy — ﬂ A ) L) (] Fin~ #
PoE 3 Fomat panter BB Merge & center - | (1§ ][9] | Concitonal’ Formet | ce | msert et Format ||, S Tno®
Ciipboard 5 Font 5 Alignment 5 Number 5 stes celts Editing ‘
HY ~ £ 2
A B C D E G [ H ] J K L N ) P
5
2 Material Price Quotes:
3 Component Description Quantity Unit Cost/Unit
4 Leather Exterior leather 1 sf s 19.860
5 Intemal Arch Support _ Molesole arch support 1,000 lot 2.236.000
6 Sole Polymer resin -preformed 12 lot 124.450
7 |Laces ‘Smooth leather 1 inch 0.047
8 Tim ‘Suede appliques - set of 3 1 set 4.250
9 [Trim Wedge logo insert 1 each 1570
10
11 Cost Calculations per Shoe:
12 Component Quantity Unit Total Cost
13 Leather 123sf s u
14 Intemal Arch Support leach § 2 b
Trim (applique set &
15 logo) 2 setleach §
16 Laces 315 inches §
17 Materials Total s
18
19
2
21
2
2
2
2
2
27
2

%4> ] Sheet1 Sheet (2)

Sheet2 Sheet3 #J





image11.png
Insert

Page Layout

Formulas

Data

s - TIEE e ¢
(3 Copy — ﬂ A ) L) (] Fin~ #

PoE 3 Fomat panter BB Merge & center - | (1§ ][9] | Concitonal’ Formet | ce | msert et Format ||, S Tno®
Ciipboard 5 Font 5 Alignment 5 Number 5 stes celts Editing ‘
N27 ~ £ 2

G J K L M [N | O P

5

2 Waterial Price Quotes:

3 Component Description Quantity Unit Cost/Unit

4 Leather Exterior leather 1 st 5 19.860

5 Intemal Arch Support _ Molesole arch support 1,000 lot 2.236.000

6 Sole Polymer resin -preformed 12 lot 124.450

7 |Laces ‘Smooth leather 1 inch 0.047

8 [Tim ‘Suede appliques - set of 3 1 set 4.250

9 Tim Wedge logo insert 1 each 1570

10

11 Cost Calculations per Shoe:

12 Component Quantity Unit Total Cost

13 Leather 123 st 524.42780

14 Intemal Arch Support leach  § 223500 b

Trim (applique set &

15 logo) 2 setleach §11.64000

16 Laces 315 inches S

17 Materials Total 53978330

18

19

2

21

2

2

2

2

an —

2 T

W4 > vi] Sheet1 ~Sheeti (2) ~Sheet2

Sheet3 , ¥J1





image12.jpeg
Table 1.4: Formats for displaying values

Description Display Actual Value Stored Example

Display varying number of | 2 2.201 (stored in cell B2) | =100*B2 results in the

decimal places value 220.1

Display using percent 5% 0.05 (stored in cell B3) 100783 results in the
valve 5

Date display 12/31/2004 | 38352.00 (stored in cell B4) | =B4+1 results in the value

38353 or, if formatied as @
date, displays 1/1/2005
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Figure 1.13: Insert Function dialog box
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Table 1.5: Commonly used Excel functions

Function (arguments)

Description

SUM(number 1, number2, -..)

Caleulates the sum of a list of values

AVERAGE[number1, number2, -..]

Calculates the average value of a list of valves

MIN{numberl, number2, -..)

Caleulates the minimum value in a list of values

MAX[number1, number2, .-

Calculates the maximum value in a list of values

COUNT{number1, number2,

)

Determines the number of values in a list
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Figure 1.14: Worksheet revised fo include average, minimum, and meaximom costs
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Figure 1.18: Possible workbook designs
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Figure 1.20: Copying formulas with relafive cell references
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Figure 1.22: Using absolute and mixed cell referencing
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Figure 1.25: Annual budget summary
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Table 1.1: Excel error messages

Error Message | Description

#hntnn nsuffcient widh in cell o display numerical data, or negative date/fime
#NAME? Unrecognized text in a formula

#N/A No answer

#REF| nvalid coll reforence

#VALUEL Wrong argument type or operand

#NUMI Invalid numeric values in o formula or function

#DIV/01 Division by zero





